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Appendix A
Enzyme Kinetics
How Enzymatic Rate Changes with Changing Substrate Concentration
If you were in charge of a cellulosic ethanol plant, you would want to ensure that the
enzyme that you were using is the most efficient one available for the job. To compare how
well an enzyme performs relative to another, you would want to compare the enzymatic
activity of the different enzymes under a given set of conditions. Enzymatic activity, or how
well an enzyme catalyzes a reaction, can be expressed in terms of the maximum rate of a
reaction or Vmax and a second term that describes the efficiency of the conversion of
substrate to product which is called the Michaelis constant (Km).
An enzyme can work at its maximum rate (also known as Vmax or maximum velocity) when
its active sites are completely saturated with substrate. This occurs only at extremely high
substrate concentrations when there is a negligible time delay in the enzyme binding to its
substrate. However, the maximum velocity of the enzyme cannot be experimentally
measured, since it can only occur when there is substrate constantly available for every
active site of every enzyme molecule. In reality, there is always a little time delay required
for the enzyme to find its substrate in solution.
A parameter that you can determine experimentally is the initial rate of the reaction when
different starting substrate concentrations are used similar to Activity 5. If you plot the initial
velocity of the reaction vs. the concentration of substrate, you will generate a graph similar
to the one shown in Figure 12.

Fig. 12. The relationship between the initial velocity of an enzymatic reaction and the substrate
concentration added at the beginning of the reaction.

Vmax is approached but never achieved at extremely high substrate concentrations.
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Equation 1:

Vo = Vmax * [S]
(Km + [S])

Where
Vo

= the initial rate of reaction at a specific starting substrate concentration

Vmax = the maximum velocity of the reaction
[S]
Km

= concentration of substrate
= Michaelis constant (see derivation below) specific to each enzyme-substrate system

The Michaelis contant (Km) is another parameter used to describe enzyme function. It is
equivalent to the substrate concentration where the reaction proceeds at half of the
maximum rate. In the case where the initial rate of reaction, Vo, is equal to ½ the maximum
rate, plugging into the Michaelis-Menten equation we get the following:
Equation 2:

½Vmax = Vmax * [S]
([Km + [S])

Solving for Km, we get Km= [S], when Vo= ½Vmax. This means that the Michaelis constant is
equal to the substrate concentration that results in an initial rate of reaction that is one half
that of the maximum rate of reaction.
Deriving the Michaelis-Menten Equation
Where does the Michaelis-Menten equation come from and what does Km mean in terms of
the reactions actually occurring? Km can also be understood in terms of the rate constants
involved in an enzymatic reaction. When an enzyme (E) is added to a substrate (S), an
enzyme-substrate complex (ES) is formed. The equilibrium constant for the formation of
this complex is described as k1. The enzyme-substrate complex can result in the formation
of product (P) with a rate constant of k2 and the liberation of the enzyme (E) or the ES
complex can fall apart without the substrate being converted to product and a rate constant
of k–1.
k2
k1
E + S ´ ES Æ E + P
k–1
The rate at which product is formed is determined by the concentration of the enzyme
substrate complex, [ES]. When there is excess substrate, then [ES] is much higher than the
concentration of free enzyme [E]. This is when the rate of the reaction is at Vmax.
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Since Vmax cannot be determined experimentally, it is useful instead to determine a
mathematical relationship between Vmax and factors that can be determined or controlled
experimentally, namely the initial reaction rate (or initial velocity of the reaction, Vo) and the
starting substrate concentration, [S]. The relationship between the maximum velocity Vmax,
the initial velocity (Vo), the substrate concentration ([S]), and a constant term that is specific
to each enzyme-substrate system Km is the Michaelis–Menten equation that is represented
below.
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In steady state equilibrium, the rate at which the enzyme-substrate complex is formed is
equal to the rate at which it is broken down. Since the rate of any reaction = (the equilibrium
constant) *(concentration of reactants), then we can say that
Equation 3:

k1[E][S] = k–1[ES] + k2[ES]

This equation can be rearranged algebraically by factoring out the [ES] on the right side of
the equation and then dividing both sides of the equation by k–1 + k2, giving the following
equation
Equation 4:

[ES] = k1[E][S]
k–1 + k2

At any point in time, the fraction of enzyme that is bound to substrate (F) can be described
by the following equation
Equation 5:

F=

[ES]
([ES] + [E])

So if we algebraically combine Equations 4 and 5 (not an easy bit of algebra) we get
Equation 6:

F=

[S]

{( k–1 + k2)/ k1} + [S]
Since the fraction of the enzyme that is bound to substrate can be expressed in the following
equation
Equation 7:

Vo = Vmax * F

We can do one more substitution to get
Equation 8:

Vo =

Vmax * [S]
{( k–1 + k2)/ k1} + [S]

Compare Equation 8 to the Michaelis-Menten equation (Equation 1). Vo = Vmax * [S]
(Km + [S])
Thus, Km is defined in terms of the rate constants of the reaction. So we have now defined
Km in terms of an actual reaction that is occurring.
Equation 9: Km = (k–1 + k2)/k1
Making the Plot Linear
Once again, we would like to determine the Vmax and Km values for our enzyme so that it
can be compared to other enzymes. Since the curve in Figure 12 is hyperbolic, it is difficult
to determine exactly where Vmax is. To solve that problem, it is best to take the inverse of
both the Y values (initial rates) and the X values (substrate concentration). This will produce
a linear graph called the Lineweaver–Burk plot or double reciprocal plot (Figure 13).
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Fig. 13. A Lineweaver-Burk plot. The linear representation of the reaction rate data was used to calculate the
Michaelis constant Km and the maximum reaction rate Vmax.

There are advantages of having a linear representation of the data. Not only can you see
how good your data are (how close to linear they are with a linear regression calculation),
but you can also more accurately determine Vmax and Km by taking the inverse values of the
X and Y intercept. Using the components of this kit and a protocol similar to Activity 5, it is
possible to determine the Vmax and Km values for the cellobiase provided in the kit.
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Biofuels
Types of Biofuels
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When the term “biofuels” is used, it generally refers to a group of fuels that are produced
from a biological source that was recently living, in contrast to fossil fuels that were created
from biological sources long dead. Current biofuel technologies tend to fall into four main
categories – cellulosic ethanol, ethanol production from sugar and starch sources, syngases,
and biodiesels. Cellulosic ethanol is primarily produced from the breakdown of cellulose to
glucose followed by a fermentation step to ethanol. Another method of ethanol production
involves breaking down starches to sugars followed by fermentation to ethanol. Biodiesels
are fuels derived from oils, either recycled cooking oils or directly from plants that produce
high levels of oils that can then be purified and burned in diesel engines. Work is also being
done to genetically modify algae, yeast and bacteria to produce fatty acids and oils that can
be used as biodiesel sources. Syngas stands for synthetic gas and is a mixture of carbon
monoxide and hydrogen gases resulting from burning biomass. Syngas can be burned
directly for power generation or chemically converted to be used in modified diesel engines.
The remaining information will primarily deal with cellulosic ethanol but more references on
starch-based ethanol production, syngas and biodiesel can be found in Appendix H.
First Generation Ethanol Production for Fuel
Currently, much of the ethanol used in the fuel industry is a result of conversion of starch,
such as that found in corn kernels, to sugar for fermentation to ethanol. Conversion of
starches to sugar has two primary drawbacks. First, it takes away a food source from
people and livestock. Second, a lot of the corn plant goes to waste, since the only
polysaccharide that is converted to ethanol is the starch of the corn kernel. Converting the
waste products of food plants or plants that are not used as a food or feed source into fuel
is a potential method to produce fuel more sustainably. For these reasons, current research
into the production of ethanol as a fuel source is concentrating on the use of cellulose
rather than starches. However, the technology to produce ethanol from cellulose is much
more complicated than from starches. Appendix F has a debate structure to help investigate
the future of biofuels.
Are Cellulosic Ethanol Biofuels a Carbon Neutral Alternative to Petroleum?
Plants convert carbon dioxide from the air into the cellulose of their cell walls. If cellulose is
broken down into sugar, converted into fuel, and later burned into carbon dioxide, then the
process is not adding or taking away any carbon dioxide from the biosphere. This is called
a “carbon neutral” process. However, converting corn stalks, husks, grasses, or other
non-food plant products to ethanol does require some petroleum. Currently the fertilizers
used to grow the crop, the tractors and other farm equipment involved in growing and
harvesting, as well as the energy required to process the plants to create the ethanol all
either directly or indirectly require petroleum. Experts calculate that it takes 1 gallon of gas
to produce 5 gallons of cellulose-derived ethanol (Montenegro 2006).
Burning fossil fuels is not carbon neutral. This carbon was fixed from carbon dioxide millions
of years ago. All the carbon in fossil fuels has been essentially locked out of the natural
carbon cycle (Martin 2008). Burning fossil fuels adds carbon dioxide to the carbon cycle,
which increases the amount of green house gases contributing to the current global climate
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crisis (Figure 13). If the world could use less petroleum and increase the usage of materials
produced from plants in a sustainable manner, we could reduce green house gas emissions.

Fig. 13. A carbon cycle with the inclusion of biofuel production and use. Plants remove carbon dioxide from
the atmosphere, and in the presence of sunlight they can convert it to complex polysaccharides including cellulose.
Plants, such as switchgrasses and poplar trees, can then be harvested and processed in a cellulosic ethanol plant
to produce ethanol to fuel planes, cars, and trucks. However, the tractors/vehicles used to process the switchgrasses,
trees, and plants and the vehicles running on cellulosic ethanol still do produce carbon dioxide. Other sources of
carbon dioxide are from respiration of animals, burning of fossil fuels, and breakdown of organic matter by
microbes. Ideally, carbon dioxide produced by the production and processing of biofuels will be reabsorbed by
plants used to make the cellulosic ethanol. This is not the case with fossil fuel usage. Fossil fuels only contribute to
carbon dioxide production.

Photosynthetically Efficient C4 Plants
Many of the plants that are considered biofuel crops are C4 plants. These plants, such as
corn, sugar cane and switch grass (native prairie grass), photosynthesize with amazing
efficiency, which means that they produce sugar at a much faster rate than other plants.
This allows them to grow rapidly and incorporate the sugars into the production of cellulose
quicker than other plants.
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It is also important to maintain the nitrogen cycle in a way that is sustainable and beneficial
to the biosphere. If crops are harvested for the production of cellulosic ethanol, the nitrogen
that was removed from the soil to become the biomolecules in the crops is lost from the
soil. If inorganic fertilizers are used to replace this loss, then there are two drawbacks. First,
it takes fuel to produce inorganic fertilizer. Second, nitrogen-based green house gases
(namely nitrous oxide) are up to 300 times more potent than carbon-based green house
gases. These nitrogen-based gases are released from soils that have been fertilized (Smith
2009). These problems can be solved by either using the wastewater and biomass from
the cellulosic fuel plant to fertilize the fields (and thus return the nitrogen to the soil) or by
using a nitrogen-fixing crop such as alfalfa as a cover crop. Alfalfa, which is grown routinely
as a feed crop for cattle, has the advantage over other grasses in being able to fix nitrogen
from the air through a symbiotic relationship with bacteria living in its roots. Since alfalfa
obtains nitrogen from the air, no nitrogen-based fertilizers are needed. In the future, both
carbon and nitrogen could be recycled through the use of biofuels.
Engineering Enzymes for Hydrolysis
Ideally, the process required to produce ethanol from cellulose should be optimized to
produce the largest amount of ethanol with the least amount of energy and cost input.
Much work is being done to improve the efficiency of the enzymes used to break down
cellulose. Since the process of producing sugars from plant material requires high
temperatures or extreme pH, the enzymes involved in cellulosic ethanol production have to
be able to function under these conditions. Scientists can use different methods to produce
enzymes that work efficiently under extreme conditions. One method is to find organisms
such as bacteria or fungi that live in similar conditions that produce the desired enzymes.
Hot springs, acidic bogs, or alkaline soda lakes (Tiago et al. 2004) are a wonderful place to
find microbes that produce enzymes that function at high temperatures, low pH, or high pH,
respectively. Another method is to mutate microbes with ultraviolet light or chemicals, and
select for those that produce enzymes with the desired characteristics. It is also possible to
engineer a mutation only in the gene of interest by cloning the gene that codes for the
cellulase enzyme of interest, which is then copied by a technique called “error prone PCR”.
This will produce an assortment of mutations that can be ligated into plasmids and
transformed into bacteria. The transformed bacteria can be screened for cellulases that
work in the desired conditions (Arnold and Georgiou 2003).
Microbial Fermentation
Once glucose is produced from the enzymatically treated cellulose, it still needs to be
processed into fuel. The most common fuel that is produced from glucose is ethanol. Yeast
is an organism that is very efficient at converting sugar to ethanol in a process called alcohol
fermentation. Bacteria such as Zymomonas mobilis and Escherichia coli are being
engineered to efficiently produce ethanol from glucose. If hemicellulose is not separated
from the cellulose after initial treatment of the plant sources, five carbon sugars such as
xylose and arabinose can be produced from the hemicellulose. Other organisms that have
enzymatic pathways for these five carbon sugars have been utilized to convert them to
ethanol. Bio-engineered yeast strains that can metabolize all the sugars produced in the
break down of plants are being developed as well.
Practicality of Ethanol as Fuel
Vehicles can run on 85–100% ethanol. In Brazil, most city buses run solely on ethanol.
Many cars that use traditional gasoline can be converted to use fuel that is a mixture of
85% ethanol and petroleum (E85).
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Appendix C
Measuring the Amount of p-Nitrophenol Produced
Using the Bio-Rad SmartSpec™ Plus
Spectrophotometer
Operation of the SmartSpec Plus spectrophotometer is easy and intuitive. Brief instructions
have been provided below. For more detailed information, please refer to the SmartSpec
Plus spectrophotomer instruction manual. Text shown below in boxes is the text seen in the
data window of the SmartSpec Plus spectrophotometer. The cuvettes must be inserted in
the correct orientation to obtain a proper reading.
1. Turn the SmartSpec Plus spectrophotometer on and press the “.l” button.
Enter number (1–3) of
wavelengths to read: 1
Type 1, and press Enter.
2. Choose the wavelength.
Enter wavelength:
_______nm
Type 410, and press Enter.

Do you want to substract
background reading? NO
Select NO, and press Enter.
4. Place cuvette with the S1 (0 nmol p-nitrophenol) standard into the chamber with the
smooth side facing the light path.
Read to read absorbance
<=Exit Assay >= Options
Press Read Blank.
A410=0.00
>=continue

Press right arrow

to continue.
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3. Turn background subtraction off.

5. Remove the cuvette that contains the S1 standard, and place the S2 standard cuvette
in the chamber with the smooth side facing the light path.
A410=0.250
Samp #1
Press Read Sample.
The A410 value will vary with the preparation of your standards, and if you have done
more readings, then the Samp # will reflect this.
Record the A410 value. This is the absorbance that corresponds with 25 nmol of
p-nitrophenol.
6. Remove the S2 standard cuvette from the chamber, and follow step 5 to read the
remaining standards (S3–S5).
Standard
S1
S2
S3
S4
S5

Absorbance
at 410 nm
0.000

Concentration (nmol/ml)
0
25
50
100
200

APPENDIX C
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Appendix D
Measuring the Amount of p-Nitrophenol Using the
Vernier SpectroVis Spectrometer
Using the Computer Procedure
1. Connect the spectrometer to your computer using a USB cable. Launch the Logger Pro
software. Once the software is open, choose New from the File menu.
2. The S1 cuvette will serve as your blank for Activities 1–5. Cuvette #6 will serve as your
blank for Activity 6. To correctly use cuvettes, remember to:
•

Wipe the outside of each cuvette with a lint-free tissue

•

Handle cuvettes only by the top edge of the ribbed sides

•

Dislodge any bubbles by gently tapping the cuvette on a hard surface

•

Always position the cuvette so the light passes through the clear sides

3. Calibrate the spectrometer.
a.

Place the S1 cuvette (Activities 1-5) or Cuvette #6 (Activity 6) into the cuvette slot
of the spectrometer.

b.

Choose Calibrate ► Spectrometer from the Experiment menu. The calibration
dialog box will display the message “Waiting 60 seconds for lamp to warm up.”
After 60 seconds, the message will change to “Warmup complete.”

c.

Select Finish Calibration. When the Finish Calibration button is grayed out,
click
.

a.

Remove the cuvette from the spectrometer. Place the S5 cuvette into the
spectrometer.

b.

Click
. A full spectrum graph of the solution will be displayed. Note that one
area of the graph contains a peak absorbance. Click
to complete the
analysis.

c.

To save the graph of absorbance vs. wavelength, select Store Latest Run from
the Experiment menu.

d.

To set up the data collection mode and select a wavelength for analysis, click the
Configure Spectrometer Data Collection icon, , on the toolbar.

e.

Click Abs vs. Concentration under the Set Collection Mode. The wavelength of
maximum absorbance (l max) will be selected. Deselect any wavelengths below
410 nm that have been autoselected. Select the wavelength closest to 410 nm.

f.

Enter Amount for the column name. Enter Amt. for the short name. Enter nmol as
the units.

g.

Click

. Remove the cuvette from the spectrometer.
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4. Determine the optimum wavelength for examining the absorbance of p-nitrophenol.

5. You are now ready to collect absorbance data for the standards. Click
. Obtain
the cuvette labeled S1. Wipe the outside with a tissue and place it in the device. Wait
for the absorbance value displayed on the monitor to stabilize. Then click
, type 0
in the edit box, and press ENTER. The data pair you just collected will now be plotted
on the graph. Remove the cuvette from the device.
6. Obtain the cuvette labeled S2. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, click
, type 12.5 in the edit box,
and press ENTER.
7.

Obtain the cuvette labeled S3. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, click
, type 25 in the edit box, and
press ENTER.

8. Obtain the cuvette labeled S4. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, click
, type 50 in the edit box, and
press ENTER.
9. Obtain the cuvette labeled S5. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, click
, type 100 in the edit box,
and press ENTER. When you have finished click
.
10. In the Quantitative Determination of Amount of Product Formed section of the
instruction manual, record the absorbance for each of your standards S1–S5 in Table 3.
11. Examine the graph of absorbance vs. concentration.
a. To see if the curve represents a direct relationship between these two variables,
click Linear Fit, . A best-fit linear regression line will be shown for your data
points. This line should pass near or through the data points.
b.

Print a copy of this graph to be used as your standard curve. You can also record
the slope and y-intercept of the line, and use the linear fit equation to calculate the
concentrations of your reaction time points from the absorbance values.

12. You are now ready to measure the absorbance values of the reaction time points.
Measure the absorbance values of the cuvettes labeled E1–E5, Start and End, and
record the absorbance values in Table 4. Use either the standard curve to graphically
calculate the amount of p-nitrophenol in your reaction samples or do this calculation
algebraically. See Quantitative Determination of Amount of Product Formed in
Activity 1 for more information.

Using the LabQuest Procedure

APPENDIX D

1. Connect the spectrometer to the LabQuest device using a USB cable. Choose New
from the File menu.
2. The S1 cuvette will serve as your blank for Activities 1–5. Cuvette #6 will serve as your
blank for Activity 6. To correctly use cuvettes, remember to:
•

Wipe the outside of each cuvette with a lint-free tissue

•

Handle cuvettes only by the top edge of the ribbed sides

•

Dislodge any bubbles by gently tapping the cuvette on a hard surface

•

Always position the cuvette so the light passes through the clear sides

92

3. Calibrate the spectrometer.
a.

Place the S1 cuvette (for Activities 1-5) or Cuvette #6 (Activity 6) in the spectrometer.

b.

Choose Calibrate from the Sensors menu. The following message is displayed:
“Waiting 60 seconds for lamp to warm up.” After 60 seconds, the message will
change to “Warmup complete.”

c.

Select Finish Calibration. When the message “Calibration completed” appears,
select OK.

4. Determine the optimum wavelength for examining the absorbance of p-nitrophenol.
a.

Remove the cuvette from the spectrometer. Obtain the cuvette labeled S5 and
place it into the spectrometer.

b.

Start data collection by clicking Start on the lower left corner of the screen. A full
spectrum graph of the solution will be displayed. Stop data collection by clicking
Stop on the lower left corner of the screen. The wavelength of maximum
absorbance (l max) is automatically identified and displayed in the lower right
corner of the screen. Verify that the maximum absorbance is close to 410 nm.
Select to read at around 410 nm by tapping on the displayed curve until the value
displayed in the lower right corner is 410 nm ± 1 nm.

c.

Tap the Meter tab in the upper left hand corner of the screen. On the Meter
screen, tap Mode. Change the mode to Events with Entry.

d.

Enter the name as Amount and the units as nmol. Select OK. Remove the
cuvette from the spectrometer.

5. You are now ready to collect absorbance data for the standards. Start data collection
by tapping Start in the lower left corner. Obtain the cuvette labeled S1. Wipe the outside
of the cuvette with a tissue and place it in the device. Wait for the absorbance value to
stabilize. Tap Keep and enter 0 as the concentration. Select OK. The absorbance and
concentration values have now been saved for the first solution. Remove the cuvette
from the device.
6. Obtain the cuvette labeled S2. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, tap Keep, enter 12.5 as the
concentration, and select OK.
7.

Obtain the cuvette labeled S3. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, tap Keep, enter 25 as the concentration,
and select OK.

8.

Obtain the cuvette labeled S4. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, tap Keep, enter 50 as the concentration,
and select OK.

10. To examine the data pairs on the displayed graph, tap any data point. As you tap each
data point, the absorbance and concentration values are displayed to the right of the
graph. In the Quantitative Determination of Amount of Product Formed section of
the instruction manual, record the absorbance for each of the standards S1–S5 in
Table 3.
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9. Obtain the cuvette labeled S5. Wipe the outside of the cuvette and place it in the
device. When the absorbance value stabilizes, tap Keep, enter 100 as the concentration,
and select OK. When you have finished, stop data collection by tapping Stop in the
lower left corner.

11. Display a graph of absorbance vs. concentration with a linear regression curve.
a.

Choose Curve Fit from the Analyze menu.

b.

Select Linear as the Fit Equation. The linear-regression statistics for these two
data columns are displayed for the equation in the form

y = mx + b
where x is concentration, y is absorbance, m is the slope, and b is the y-intercept.
c.

Select OK. A best-fit linear regression line will be shown for your data points. This
line should pass near or through the data points.

d.

Print a copy of this graph to be used as your standard curve. You can also record
the slope and y-intercept of the line, and use the linear fit equation to calculate the
concentrations of your reaction time points from the absorbance values.

12. You are now ready to measure the absorbance values of your reaction time points.
Measure the absorbance values of your cuvettes labeled E1–E5, Start and End, and
record the absorbance values in Table 4. Use either your standard curve to graphically
calculate the amount of p-nitrophenol in your reaction samples or do this calculation
algebraically. See Quantitative Determination of Amount of Product Formed in
Activity 1 of your instruction manual for more information.
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b-glucosidase: An enzyme that breaks apart the b 1–4 bonds that link together two glucose
molecules of cellobiose, as well as other short polymeric chains of b 1–4 bonded glucose.
These enzymes are stereospecific, meaning that they cannot also break apart a 1–4 bonds.
Cellobiase: A b-glucosidase enzyme that specifically breaks apart the b 1–4 bonds of the
two glucose molecules of cellobiose.
Cellobiose: A molecule composed of two glucose molecules that are covalently linked
together with the b 1–4 bond.
Cellulose: A polymer that consists of multiple chains of D-glucose linked together at the
b 1–4 groups. The long polymer chains of cellulose are not branched and the chains are
stiff long rods. These glucose molecules in the long cellulose chains can hydrogen bond
with each other to form long fibrils. Cellulose is one of the main components (along with
hemicellulose and lignin) that make up plant cell walls.
Endocellulase: This is a family of enzymes that breaks the internal b 1–4 bonds of cellulose
molecules (as opposed to the exocellulase family of enzymes that break the cellulose
bonds at the ends of the polymer strands). The accepted name for this family of enzyme is
cellulase. See http://www.expasy.org/enzyme/3.2.1.4 for alternative names.
Enzyme: A biological molecule (usually a protein, but can also be a nucleic acid) that
increases the rate of reaction by reducing the activation energy of the reaction but is not
itself consumed in the reaction.
Exocellulase: This is a family of enzymes that cuts and releases cellobiose from the
reducing (cellobiohydrolase I family) and non-reducing ends (cellobiohydrolase II family) of
cellulose polymeric chains. The accepted name for this family of enzymes is cellulose
1,4-b-cellobiosidase. For alternative names see http://www.expasy.org/enzyme/3.2.1.91.
Hemicellulose: A polymer that consists of chains of five-carbon and six-carbon sugar
groups. Hemicellulose does not have a crystalline structure, but instead consists of
amorphous chains within plant cell walls. Hemicellulose is also a branched molecule in
contrast to cellulose which is linear.
Lignin: A complex aromatic polymer. Lignin adds stiffness and strength to plant cell walls.
This polymer does not have a carbohydrate structure like cellulose and hemicellulose but
does serve to bind those polymers together in the cell wall of plants.
Polysaccharide: A polymer chain made up of multiple sugar groups linked together.
Product: The compound or compounds that are produced when an enzyme acts upon a
substrate.
Substrate: A compound that is acted upon by an enzyme producing a product.
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Appendix E
Glossary of Terms

Appendix F
Biofuels Debate
Post-Lab Debate Activity

APPENDIX F

Many people object to the use of crops for biofuel production. They argue that by using
crops for fuel, resources are reduced for the use of the crops or cropland for food for people
or animals. Many are concerned with the removal of essential nutrients from the fields if
non-food portions of crops are used for fuel and are not left fallow on fields as natural fertilizer.
Proponents of cellulosic ethanol argue that the use of non-food portions of food crops such
as corn stover and cover crops such as switchgrass is better for the environment. These
waste products of food and feed production can be harvested and used for ethanol
production and would result in carbon neutral transportation fuels. In addition, the largest
amount of biomass in the world is present in the cellulosic portions of plants, and hence this
would be a renewable fuel source, unlike petroleum. Here we include a debate activity to
facilitate discussion of these issues.
Day 1: Set the Stage
Randomly divide the class into two groups and assign one group to support and the other
to oppose the development and use of cellulosic ethanol technology for biofuel production.
Explain the format of the debate and have each team pick a captain.
Days 2–5: Student Research
•

Students conduct research on the development and use of cellulosic ethanol technology
for biofuel production using the pro/con data sheet on the next page (optional: assign
for homework)

•

Teams compile research from all members

•

Teams write 4-minute opening statements and assign spokespersons

Day 6: The Debate
Debate Format
Opening Statement: Proponents of cellulosic ethanol technology for biofuel production
present an opening statement outlining the benefits of cellulosic ethanol technology
(4 minutes).
Break: Opponents assemble a list of questions they believe show holes in the proponents’
argument (2 minutes).
Questions: Opponents present questions (2 minutes).
Opening Statement: Opponents of cellulosic ethanol technology for biofuel production
present an opening statement outlining the reasons cellulosic ethanol technology should
not be allowed (4 minutes).
Break: Proponents assemble a list of questions they believe show holes in the oppositions’
argument (2 minutes).
Questions: Proponents present questions (2 minutes).
Rebuttal: Proponents present answers to opponents’ questions (2 minutes).
Rebuttal: Opponents present answers to proponents’ questions (2 minutes).
Closing arguments: Opposing view (3 minutes).
Closing arguments: Supporting view (3 minutes).
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